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1 Introduction 

Ce présent tutoriel a l’intention d’illustrer l’idée de liaison dynamique entre WEAP et MODFLOW.  

Les techniques ici présentées sont gardées le plus simple possible pour vous familiariser avec les 
étapes à suivre dans la construction d’un modèle WEAP lié avec MODFLOW et pour vous donner une 
introduction générale sur comment résoudre des problèmes de gestion de l’eau. 

La première partie vous guidera à travers la construction du modèle WEAP basé sur des données 
stockées  dans un modèle MODFLOW (“Hard Data approach”).  Malgré le fait que cette approche 
n’est pas  flexible et que des nombreuses options de modélisation de WEAP  ne sont pas disponibles, 
elle est utile si les données mesurées (p.ex. précipitation) utilisées pour construire et calibrer un 
modèle MODFLOW ne sont pas disponibles pour une raison quelconque.        

La seconde partie se focalise sur la construction et la liaison d’un modèle en utilisant les fonctions 
internes de WEAP pour estimer la recherche de l’eau souterraine et le ruissèlement de surface. 

Dans la dernière partie, vous apprendrez comment vous occuper des défis typiques pour les 
modélisateurs comme l’implémentation de recharge artificielle ou le changement d’occupation de 
sol. 

Avant de commencer avec le tutoriel, on conseille à avoir téléchargé les fichiers « shape files » 
associés (Catchment.shp, Landuse.shp, Wellfields.shp) ainsi que le fichier « csv » (InputData.csv). 

Ce tutoriel se réfère à la version 3.001 de WEAP (Sep. 2012) et l’outil LinkKitchen version 1.00 (Sep. 
2012). Il est également basé sur le tutoriel WEAP-MODFLOW par BGR/ACSAD (2009) et inclut 
contributions de M. Al-Sibai (Chapitre 2). 
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2 Modèle MODFLOW 

Le modèle MODFLOW utilisé dans ce tutoriel a été désigné avec l’intention d’inclure plusieurs 
options de gestion (barrages, irrigation) tout en restant facile à comprendre. Il est une modification 
du model original utilisé dans le GMS-tutoriel et dans le suivant sera appelé « Main River Basin ». 

 

2.1 Zone du modèle – “Main River Basin” 

Le bassin versant étudié couvre 783 Km². Il est localisé dans un climat semi-aride avec des 
précipitations uniquement aux mois de l’hiver. La majorité de la précipitation est perdue sous forme 
d’évapotranspiration. L’aquifère est composé du socle cristallin fracturé et des alluvions dans les 
vallées. Son épaisseur saturée varie du 35 m au sud à environ 53 m au nord.  

L’écoulement souterrain est vers la source, la rivière principale « Main River » et ses deux affluents. 
La source représente le début du « Main River » avec débit mensuel moyen d’environ 320 000 m3. Au 
nord, au-delà de la zone du modèle, « Main River » draine finalement dans un lac avec un niveau 
d’eau constant à 304,8 m.a.s.l. (au-dessous du niveau de la mer). 

La topographie diminue graduellement du sud (353 m.a.s.l) au nord (335 m.a.s.l) 

 

 

 

 

 

 

Elevation

dem

Value

High : 353.331146

 

Low : 334.447601
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2.2 Modèle mathématique 

Grille : le modèle se compose d’une couche (1 aquifère non confiné, épaisseur de la couche 60-80 m, 
épaisseur saturée 35-50 m) avec 80 x 70 éléments. Les dimensions des éléments varient en largeur et 
en hauteur entre 200 et 1200 m (voir figure en bas). 

 
 

CONDITIONS LIMITES: charge imposée au nord (niveau du lac). Toutes les autres limites sont des 
limites à débit nul (voir figure plus haut). 

CONDUCTIVITE HYDRAULIQUE: les quatre zones de conductivité hydraulique pour le modèle sont 
montrées dans la figure suivante. La conductivité hydraulique de l’aquifère varie de 100 m/jour le 
long la vallée du fleuve à 40 m/jour vers les limites du bassin. 

 
 

Model Boundaries & Stresses
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River

Spring

N
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RECHARGE : 5 différentes zones de recharge sont définis. Leur valeurs varient de 0 à 0,0015 m/jour. 

PACKAGES ADDITIONNELS : la source est représentée avec deux éléments « DRAIN » (en mauve dans 
la figure précédente) et les rivières par des éléments « RIVER » (en bleu dans la figure précédente). 

CHARGE INITIALE : la charge initiale varie entre 306 et 327 m.a.s.l., résultant en une profondeur de la 
surface libre de l’eau de 25 à 36 m (voir figure en bas). 

 

Charges initiales :     Profondeur de la surface d’eau libre : 

 
Le modèle est construit et exécuté en conditions transitoires pour couvrir deux années de variation 
de la recharge. Il consiste en 24 périodes de stress, chacun avec 3 pas de temps égaux. Le bilan d’eau 
final (voir figure en bas- unités en m3 ou m3/jour) montre que le modèle est presque balancé ou 
proche de l’état stationnaire avec la recharge comme seule alimentation de l’aquifère et le fleuve 
comme la principale fraction de débits sortants. 
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3 Créer et Lier un Modèle WEAP Basé sur des Données 
MODFLOW  

Au début, vous allez créer un nouveau projet « WEAP - Area » et lui dessiner un schéma. Les activités 
à suivre sont :   

 Créer un nouveau projet « WEAP - Area » 

 Définir les limites de la zone de travail 

 Charger les couches de fond 

 Digitaliser quatre fleuves 

 Ajouter cinq sous-bassins versants « Catchments » et cinq nœuds eau souterraine 
« Groundwater ».  

 

Le résultat obtenu va se ressembler à la figure suivante. 
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3.1 Créer un nouveau « WEAP – Area »  

1. Dans le menu principal de WEAP, allez sur « Area → Create Area ». Dans la fenêtre suivante, 
créer un nouveau projet « Area » que sera initialement vide (initially blank) et lui donner le 
nome «DSS-Tutoriel »  
 

   
 

2. Cliquer sur « Ok » et ignorez la fenêtre suivante « Area boundry » en cliquant sur « Cancel ». 
Le modèle devrait se ressembler à la figure ci-dessous :  
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3.2 Commencer LinkKitchen 

LinkKitchen est un utile basé sur les principes SIG désigné pour assister à la création du fichier de 
liaison « Linkage Shapefile » sans faire appel aux autres logiciels soit SIG ou tables. Il fournit toutes 
les fonctionnalités nécessaires pour produire le fichier de liaison et pour son attribution. En outre, il 
permet un paramétrage direct du modèle WEAP basé sur la liaison des attributs du fichier. 

Si vous n'êtes pas encore familiarisé avec l'utilisation de LinkKitchen, on vous recommande de lire le 
manuel d’utilisateur avant de continuer avec ce tutoriel. 

 

Gardez WEAP ouvert et démarrez LinkKitchen en parallèle. 

Au démarrage vous êtes invité à sélectionner l'un de vos modèles 
WEAP sur lequel vous allez travailler. Sélectionnez « DSS-Tutorial » 
et confirmez en cliquant sur OK. 

Dans la fenêtre suivante, LinkKitchen demande l'emplacement du 
modèle MODFLOW et le fichier de liaison. Recherchez le modèle 
MODFLOW qui vient avec les données du tutoriel et sélectionnez 
le nom du fichier « NameFile ». Comme le fichier de liaison 
n'existe pas encore, choisissez : créer un nouveau fichier de 
liaison. 

Une fois que vous confirmez avec OK, tous les fichiers MODFLOW 
seront copiés dans le répertoire standard du « WEAP-Area ». 

LinkKitchen produit le fichier de liaison ainsi que deux autres 
« shapefiles » dans le fond. Ceux-ci seront utilisés lors des 
prochaines étapes. 
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3.3 Définition des limites de « WEAP Area » 

L’interface de LinkKitchen montrera une grille vide qui représente la géométrie de votre modèle 
MODFLOW. C'est le fichier de liaison. 

 
 

Revenez à WEAP (ne fermez pas LinkKitchen). 

 

Faites un clic droit dans la fenêtre des couches et 
sélectionnez « Add Vector Layer » dans le menu 
contextuel. 

Accédez au répertoire de votre « WEAP Area » : WEAP 
Area « /SHAPE » et sélectionnez le fichier 
MF_Domain_trans_modify_5f_drain.shp. Ce fichier a été 
créé au démarrage de LinkKitchen et représente la limite 
spatiale du modèle MODFLOW. Vous allez utiliser ce 
fichier pour définir les limites du model. 

 

Eliminez toutes les autres couches (Major Rivers, States, 
Country, Ocean) sauf 
MF_Domain_trans_modify_5f_drain.shp. 
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Faites un clic droit dans la fenêtre des couches et 
sélectionnez « Set Area Boundaries » dans le menu 
contextuel. 

 

 

 

 

 

 

 

Dessinez un rectangle vert (la limite de la zone) autour de 
l'étendue complète du rectangle noir (qui mesure 
exactement le modèle MODFLOW) et confirmez en 
cliquant sur OK. 
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3.4 Ajouter des sous-bassins et des nœuds eaux souterraines au 
schéma 

Il est supposé que MODFLOW est la seule source d'information sur la zone du modèle. Les sous-
bassins et les nœuds des eaux souterraines sont donc délimités par les zones avec recharge 
uniforme. Vous utiliserez LinkKitchen pour délimiter le bassin versant et les zones des eaux 
souterraines dans WEAP. 

 

1. Passez en LinkKitchen et recherchez la couche « Recharge SP1 » de MODFLOW  dans MODFLOW-
Viewer. Cliquez sur le bouton « Preview »  pour visualiser les zones de recharge. 
 

 
 

2. Cliquez sur le bouton « Make Snapshot »   pour sauvegarder l'image d’une façon permanente 
sur le disque. L'image apparaît dans la liste des couches en tant que une couche de fond régulier. 

 

A ce stade, les zones de recharge sont sauvegardées comme un fichier image au format JPEG dans le 
répertoire « WEAP-area ». Le fichier ne contient aucune information à part d’une couleur différente 
pour chaque zone. 
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3. Revenez à WEAP et chargez le fichier "Recharge_SP1.jpg" comme une couche de fond pour le 
schéma. 
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Cinq zones de recharge différentes sont définies dans le modèle MODFLOW. Vous allez prendre ces 
zones comme un plan pour la délimitation des sous-bassins versants et les WEAP-nœuds des eaux 
souterraines. 

1. Faites glisser et déposez un nœud « Catchment » et un nœud « Groundwater » pour chaque 
zone de recharge sur le schéma. 

2. Liez les nœuds  « Catchment » et « Groundwater » par des liens de type « infiltration ». 

 

Name du sous-bassin liaison Name du nœud d’eau souterraine 

C_East infiltration link GW_East 

C_MainCentral infiltration link GW_MainCentral 

C_MainLower infiltration link GW_MainLower 

C_MainUpper infiltration link GW_MainUpper 

C_West infiltration link GW_West 

 

REMARQUE: Il est recommandé d'ajouter le préfixe "C_" devant les noms des bassins versants et le 
préfixe «GW_" devant les noms des nœuds des eaux souterraines afin d'éviter la confusion entre les 
noms identiques des nœuds en eaux souterraines, bassins et des sites de demande. 
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3.5 Ajouter des rivières au Schéma 

1. Ajoutez le fichier MF_River_trans_modify_5f_drain.shp (situé dans le dossier SHAPE dans le 
répertoire de WEAP-Area) au Schéma, et attribuez-le une couleur bleu « solid ». 
 

 
 

2. Faites glisser et déposez des 
nœuds de type « River » sur le 
parcoure de la rivière et digitalisez 
chaque rivière dans le sens 
d'écoulement sur la zone bleue. Les 
noms des rivières sont Main River, 
East River and West River. East River 
et West River sont les affluents de 
Main River. 

 
 

 

 

 

 

3. Une quatrième rivière doit être digitalisée en plus des trois rivières. En 
MODFLOW, il est représenté par deux éléments de drainage en amont de la 
Main River. Cette rivière est nommée Spring (elle représente une source 
d’eau). 
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3.6 Ajuster la période d'exécution du model dans WEAP 

Afin d'assurer que les calculs de WEAP corrèlent correctement avec le modèle MODFLOW, ajustez le 
pas de temps de WEAP et le mois de départ selon les périodes de stress de MODFLOW (ici : Octobre 
1999 – Septembre 2001). 
 

Ceci est réalisé en utilisant l’item du menue General  → « Years and Time Steps ». 

 

 
 

Initialement vous n’allez pas utiliser aucun model interne de WEAP pour calculer le ruissellement de 
surface, la recharge et la demande d’irrigation. Donc, choisissez dans : 
 
Data View → Demand Sites and Catchments → Advanced  

 
la méthode : « Irrigation demand only (FAO) » 
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3.7 Définir des bassins versants et des eaux souterraines dans le 
fichier de liaison 

Revenez à LinkKitchen et voyez comment il reflète les modifications que vous venez de faire dans 
WEAP. Les nœuds que vous avez ajoutés au schéma sont maintenant visibles dans la vue de contrôle 
de LinkKitchen. Au cours des étapes suivantes, vous allez lier des éléments du fichier de liaison avec 
des bassins versants, des eaux souterraines et des rivières. 
 

 
 

Comme vous avez les zones de recharge en arrière-plan, vous allez utiliser ces zones comme des 
stencils pour la sélection des éléments. Utilisez l’outil de sélection dans LinkKitchen (voir Manuel 
d'utilisateur de LinkKitchen) pour sélectionner les éléments correspondant aux zones de recharge. 
Les éléments ainsi sélectionnés sont ensuite attribués par le nom du bassin versant tel que défini 
dans WEAP. 
La procédure d'attribution pour les nœuds des eaux souterraines est identique. 
 

1. Sélectionnez toutes les éléments situés dans la zone verte (C_Main Upper). 
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2. Surlignez C_MainUpper dans la vue de contrôle de l’arbre et cliquez sur « Add Attribute to Linkage 
File». Cela va écrire le nom de cette branche dans le fichier de liaison. 

 

3. Surlignez GW_MainUpper et puis cliquez sur « Add Attribute to Linkage File ». 
 

 

 

 

 

 

 

 

 

 

 

 

 

3. Répétez les étapes 1 et 2 pour les autres bassins versants. 

 

4. Surligner la racine des branches « Catchments » et regardez le fichier de liaison: 
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3.8 Définir des rivières dans le fichier de liaison 

Dans WEAP, une rivière est définie comme une «chaîne» de tronçons, sections avec des nœuds 
d’entrée ou de sortie d’eau. Tout tronçon de rivière nécessite d'avoir une représentation dans le 
fichier de liaison. 
Il y a deux différentes méthodes pour attribuer les tronçons d’une rivière dans le fichier de liaison. La 
méthode à choisir dépend de la précision dont vous avez digitalisée les rivières dans le Schéma de 
WEAP. Si les rivières WEAP sont digitalisées d’une façon très précise sans aucun chevauchement des 
lignes des rivières en dehors des éléments bleus, vous pouvez opter pour la méthode 2. Si les rivières 
sont grossièrement digitalisées autour des éléments bleus, choisissez la première méthode. Les deux 
méthodes sont décrites dans la section suivante. 
 

 

 

 

 

 

 

 

 

 

 

Méthode 1: 
La procédure d'attribution de tronçons dans les éléments du fichier de liaison est similaire à la 
procédure d'attribution des bassins versants, sauf que vous commencez à partir de l'information que 
vous obtenez de MODFLOW plutôt que à partir d'un fichier « shapefile ». 

1. Dans le MODFLOW-Viewer, accédez à la couche IsDrain et cliquez sur select. Les éléments de 
drainage représentent la source de la rivière « Spring » dans  WEAP. 

 

Précis → Méthode 2 Simpliste → Méthode 1 
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2. Surlignez le tronçon Below Spring Headflow dans la vue de contrôle et cliquez sur Add Attribute to 
Linkage File. 
 

 
 

Les deux éléments de drainage sont maintenant liés au tronçon Below Spring Headflow dans WEAP. 

 

3. Accédez à la couche IsRiver dans MODFLOW-Viewer pour sélectionner les éléments de la rivière. 
 

 
 

 

4. Utilisez les outils de sélection de LinkKitchen pour une sous sélection des éléments correspondants 
aux rivières dans WEAP. 

Par exemple : Cliquez et maintenez la touche « alt » tout en dessinant un rectangle autour de West 
River afin de sélectionner les éléments de cette même rivière. 
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5. Surlignez le tronçon au-dessous de débit de tête de West River « Below West River Headflow » 
dans la vue de contrôle et cliquez sur Add Attribute to Linkage File. 
 

6. Répétez les deux dernières étapes pour tous les autres tronçons. 

 

L'aperçu de l’attribution de la rivière doit montrer une image similaire à l'image ci-dessous: 

 

 
 

 

Sauvegardez le fichier de liaison sur le disque en cliquant sur le bouton Write Linkage File 
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Méthode 2: 
Vous pouvez faire WEAP deviner les tronçons et les drains en fonction de la digitalisation de vos 
rivières dans le Schéma. Pour faire travailler cette procédure, il est nécessaire d’abord de lier WEAP 
et MODFLOW. Continuez avec le prochain chapitre et une fois que vous êtes sur le point de lier 
WEAP avec MODFLOW, cliquez sur les Boutons Guess River Point Linkages et Guess Drain Cell 
Linkages (chapitre 3.11). 

 

 
 

Remarque: il est recommandé de sauvegarder le fichier de liaison fréquemment afin de ne pas 
perdre vos modifications. Le fichier est remplacé à chaque sauvegarde. 
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3.9 Définir la relation DEBIT-HAUTEUR-LARGEUR 

Afin de permettre à WEAP de calculer correctement les fonctions relatives aux « rivières », vous avez 
besoin d’assigner un paramètre nommé « FlowStageWidth relationship ». Ce paramètre (ou 
ensemble de paramètres) décrit les propriétés physiques d’une rivière et de son lit, cela est la base 
pour WEAP pour calculer les interactions entre l’aquifère et la rivière. Si vous configurez un WEAP-
modèle à base des informations d'un modèle MODFLOW, il est probable que les informations 
nécessaires sur les rivières manquent. 

LinkKitchen fournit une méthode assez pragmatique pour affecter la relation débit-hauteur-largeur 
avec des paramètres normalisés. 

 

1. Passez en LinkKitchen et surlignez le tronçon  Spring, Below Spring Headflow. 

2. Cliquez sur le Commande  pour ouvrir la fenêtre débit-hauteur-largeur. Cette fenêtre affiche 
neuf images de rivières de tailles diverses. Faites un clic gauche sur l’image en haut gauche (cette 
image devrait se rapprocher le plus d'une source). 

 

 
 

LinkKitchen va produire une courbe débit-hauteur-largeur en fonction des paramètres enregistrés 
avec l'image (pour plus de détails, voir le guide d’utilisation de LinkKitchen). 

 

3. Cliquez sur le WEAP-bouton pour envoyer la courbe dans WEAP et puis vérifiez le résultat  
Supply and Resources → River → Below Spring Headflow → Reaches → Physical → Flow Stage Width  

 

 
 

Notez que la courbe peut être modifiée dans WEAP en utilisant le Flow-Stage-Width-Wizard. 
 
Répétez les étapes 1-3 pour toutes les autres rivières. 
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3.10  Envoyer les données du fichier de liaison à WEAP 

Dans l'approche actuellement usée, vous utilisez dans WEAP les entrées initiales du modèle 
MODFLOW plutôt que l'un des modèles intégrés dans WEAP pour le calcul de la recharge des eaux 
souterraines. Les valeurs de la recharge des eaux souterraines récupérées de MODFLOW seront des 
entrées dans WEAP. 

Data View → Supply and Resources → Groundwater → Natural Recharge.  

En tant que second paramètre obligatoire, vous devez entrer les surfaces des bassins versants dans 
WEAP 

Data View → Demand Sites and Catchments → Landuse → Area 

Les deux paramètres sont calculés par LinkKitchen et peuvent être envoyés automatiquement 
comme entrées à la position correcte dans WEAP. 

 

3.10.1 Envoyer les surfaces des bassins versants dans  WEAP 

Les surfaces des bassins versants sont calculées par LinkKitchen et peuvent être envoyées à WEAP 
par un seul clic de souris: 

 

1. Surlignez la racine des bassins versants « Catchments » et cliquez sur le bouton WEAP dans la 
barre d'outils supérieure  

 

 
 

2. Passez en WEAP et accédez à  Data View → Demand Sites and Catchments → Landuse → Area 

 

Si les unités de surface ne sont pas encore définies, vous 
devez sélectionner hectares afin de rendre les entrées 
visibles. 
 

 

 

 

 

 

La distribution des surfaces devrait ressembler à ce qui suit: 
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3.10.2 Envoyer la recharge des eaux souterraines dans WEAP 

La procédure pour envoyer la recharge naturelle dans WEAP est similaire à l'envoi des surfaces des 
bassins versants. 

1. Surlignez la racine des eaux souterraines « Groundwater » et cliquez sur le bouton WEAP 
dans la barre d'outils supérieure 

2. Passez en WEAP et accédez à    

Data View → Supply and Resources → Groundwater → Natural Recharge.  

 

Remarque: LinkKitchen calcule toutes les valeurs de recharge en millions de m³ qui est l'échelle par 
défaut pour la recharge naturelle dans WEAP. Vérifier et changer l'échelle si nécessaire! 

General → Units → Groundwater: changez l’échelle à Million m³. 

Les valeurs de la recharge devraient ressembler à ce qui suit: 
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3.11  Lier WEAP et MODFLOW  

Après avoir entré les données nécessaires à la fois dans le fichier de liaison et dans WEAP, vous êtes 
maintenant prêt à lier les deux modèles. Cela se fait par:  

 Chargement du fichier « Shapefile » de liaison dans WEAP  

 Mettre en place la liaison dans WEAP 

 

Chargez le fichier « Shapefile » de lien dans le schéma WEAP: 

Add Vector Layer → select the linkage file (linkage.shp) 

 

 
 

Dans le menu principal sélectionnez:  

Advanced → MODFLOW Link → MODFLOW Name File → MODFLOW/trans_modify_5f_drain.mfn 
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Choisissez votre fichier « Shapefile » de liaison et assignez les champs d'attributs respectifs de ligne 
et colonne, eaux souterraines, tronçons  de rivière et bassins versant (ce qui devrait être correct par 
défaut). 

Si vous n'avez pas encore attribué les tronçons (parce que vous avez opté pour la méthode 2 dans le 
chapitre 3.8), vous devez maintenant cliquer sur Guess River Point Linkages and Guess Drain Cell 
Linkages. 

 
Passez à la vue de résultats et regardez les sorties de résultat comme les niveaux piézométriques  

 (Supply and Resources → Groundwater → MODFLOW → Cell Head) etc.  
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4 Hydrologie dans WEAP Modèles Liés – Pluie-Débit 

Dans l’exercice précédent, vous avez entré les valeurs de la recharge directement dans WEAP comme 
« Natural Recharge » et délinéé les bassins versants en basant sur les zones de recharges prédéfinis 
dans MODFLOW. 

Dans le présent exercice, les nomes des bassins restons les mêmes mais reliés à des régions spatiales 
différentes (des vrais bassins versants d’eau de surface). Les surfaces des bassins seront plutôt 
repartis selon l’occupation du sol pour refléter les diffèrent besoins d’eau. 

En plus, les ruissellements de surface sont assignés aux nœuds des bassins (du bassin à la rivière). 

En ce chapitre, WEAP va calculer la recharge de l’eau souterraine en utilisant un de ses modèles 
internes appelé Rainfall Runoff (simplified coefficient method).   

4.1 Ajouter des liens de ruissellements au schéma  

Afin d’assurer que WEAP puisse calculer le ruissellement, vous avez besoin d’ajouter des liens de 
ruissellement à partir des bassins aux rivières dans le schéma de WEAP. Glissez et déposez un lien de 
ruissellement pour chaque nœud des bassins à la rivière appropriée.  

 

Bassin Ruissellement lié à Tête d’eau (yes/no) 

C_MainUpper Main River No 

C_West West River Yes 

C_East East River Yes 

C_Central Main River No 

C_Main Lower Main River No 
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4.2 Attribuer les bassins et les classes d’occupation du sol dans le 
fichier de liaison 

1. Ajoutez des sous-branches pour chaque basin.  

En vue de donnés: clique-droite sur Catchment → Add → type the name of the sub branch comme 
spécifié dans le tableau ci-dessous: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

2. Passez en LinkKitchen et chargez les deux fichiers Catchment.shp et Landuse.shp. 

 

 

3. Faites selectable la couche Catchment  

 

 

 

 

 

 

 

 

4. Changez l’attribut de la couche « Catchment » 
à “Catchment” 

 

 

 

 

 

 

5. Clique droite dans C_MainUpper et puis cliquez sur Select Cells from Overlay . 

Bassin Utilisation de sol 

C_East unirrigated 

C_East urban 

C_MainCentral unirrigated 

C_MainLower unirrigated 

C_MainLower urban 

C_MainUpper forest 

C_MainUpper irrigated 

C_MainUpper pasture 

C_MainUpper shrub 

C_West forest 

C_West pasture 

C_West unirrigated 
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6. Surlignez C_MainUpper dans la vue de contrôle et cliquez Add Attribute to selected Cells. 

 

7. Surlignez GW_MainUpper dans la vue de contrôle et cliquez Add Attribute to selected Cells. 

 

Répétez les étapes 5-7 pour les autres bassins et nœuds des eaux souterraines. 

 

8. Faites la couche “Landuse” selectable et attribuez les classes d’occupation du sol dans le fichier de 
liaison. La procédure ressemble à ceci dans les étapes 5-7.  

 

9. Envoyez les données de la zone dans WEAP. 
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4.3 Entrer les données dans WEAP 

Des entrées additionnelles au niveau du bassin sont la précipitation et l’évapotranspiration de 
référence (ETref). Les coefficients de récolte (Kc) sont entrés au niveau des classes de l’occupation du 
sol. Ces entrées sont lues dans WEAP par la fonction « ReadFromFile ». Le nom du fichier duquel les 
données vont être lues est « INPUT_DATA.csv ». Copiez ce fichier dans le sous répertoire  
« TimeSeries » du répertoire « WEAP area ». 

4.3.1 Entrer la précipitation 

1. Dans la vue de données, choisissez C_MainCentral and activate Climate → Precipitation. 

2. Cliquez sur la petite flèche à droite du casier d’entrée des données et choisissez ReadFromFile 
Wizard. 

 

 
 

3. Ouvrez le fichier \TimeSeries\INPUT_DATA.csv 

4. Dans le panneau au-dessous, choisissez Precipitation dans « data column » et cliquez sur  
« Finish ». 

 

 
 

5. Répétez les étapes 2-4 pour les autres basins. 
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4.3.2 Entrer  ETRef 

ETRef est entré de la même façon que la précipitation, mais avec la colonne de données [ET]. 

4.3.3 Enter Kc 

Allez sur Landuse – Kc et faite entrer les valeurs de Kc pour chaque classe d’occupation du sol de la 
même façon que la précipitation et ETRef.  

Les données pour les classes d’occupation du sol Irrigated et unirrigated viennent de la même 
colonne  (unirrigated).  

(Pour plus de détails sur le modèle de ruissellement Rainfall Runoff (simplified coefficient method), 
voir l’aide dans WEAP et la publication n° 56  de la FAO sur irrigation et drainage intitulé « Crop 
Evapotranspiration »). 

4.3.4 Entrer les fractions de ruissellement et d'infiltration 

Le volume total de ruissellement peut être fractionné entre ruissellement de surface et recharge des 
eaux souterraines: 
Supply and Resources → Runoff and Infiltration → from catchment (C_...) → to …→ Runoff Fraction 

Entrez une valeur de 50% pour chaque lien. 

4.3.5 Exécuter le modèle et parcourir les résultats 

Le résultat ci-dessous montre la recharge calculée et le flux de ruissellement à partir du bassin 
C_MainLower. 
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5 Tâches Courantes 

La partie suivante de ce tutoriel va vous donner quelques solutions pour faire face aux défis courant 
de modélisation. Elle n’a pas la prétention d'être complète et ne prétend pas à montrer une solution 
unique pour chaque problème posé. Mais vous pouvez utiliser certaines des approches présentées 
comme point de départ pour votre propre travail de modélisation. 

Les descriptions ci-après sont réduites aux implémentations de base et de paramétrage. Si vous 
souhaitez visualiser les impacts de chaque tâche sur le système, vous devez appliquer les 
modifications sur les scénarios et comparer les résultats avec le scénario de référence. 

5.1 Abstraction pour l'irrigation 

Il y a plusieurs façons d’introduire l'abstraction pour l'irrigation. Les deux méthodes les plus utilisées 
sont: 

1. Définir un site de demande et entrer directement l'eau prélevée 
2. Laisser WEAP calculer la demande d'irrigation en basant sur les paramètres du climat et des 

cultures 

Dans le premier cas, il n'est pas nécessaire de se soucier du climat ou des types de cultures cultivées. 
Cette méthode est facile à implémenter mais pas flexible quand il s'agit de calculer des scénarios. Le 
second cas demande plus de données à entrer, mais offre une performance meilleure pour la 
planification pour le futur. 

Les chapitres suivants montrent les deux approches. 

5.1.1 Ajouter le prélèvement pour l'irrigation par site de demande  

1. Glissez et déposez un nouveau site de demande dans la Vue de schéma et nommez-le «Irrigation». 
2. Glissez et déposez une liaison type « transmission link » à partir de l’eau souterraine 
GW_MainUpper au nouveau site de demande «Irrigation». 
 

  
3. Entrez le prélèvement d'eau pour l'irrigation dans: 

Data→ Demand sites and catchments → irrigation → water use → Annual water use 

La demande d'irrigation est de 30 millions de m3 par an. Comme l'eau n’est nécessaire que pendant 
les mois de mai et juin, l'irrigation annuelle est fractionné avec le pourcentage (40%) en mai et (60%) 
en juin. Ceci est entré au 



 

Tutorial de WEAP-MODFLOW 37/45 Tâches courantes 

Data→ Demand sites and catchments → irrigation → water use → Monthly Variation 

En utilisant le Monthly Time Series Wizard. 

 

4. Comme WEAP a besoin de reconnaitre les éléments  à partir desquels l’eau est prélevée, vous 
devez mettre à jour le fichier de liaison avec cette information. Il est supposé que l'eau est prélevée 
des puits situés partout dans la zone irriguée. Passez en LinkKitchen et surlignez la classe 
d’occupation du sol C_MainUpper/Irrigated dans la vue de contrôle. 

 

5. Cliquez sur le bouton Select Attributed Cells. 

 

6. Surlignez le site de demande irrigation et cliquez sur Add Attribute to Linkage File. Maintenant 
chaque élément se trouvant à l'intérieur de la classe d’occupation du sol « Irrigated »  fourni de l’eau 
au site de demande Irrigation. 

 
 

7. Sauvegardez le fichier de liaison sur le disque et retournez à WEAP. 
 

8. Rechargez le fichier de liaison si nécessaire et exécutez WEAP. Parcourir les résultats. 

5.1.2 Ajouter le prélèvement pour l'irrigation aux classes d’occupation du sol 

La modélisation de la demande pour l'irrigation en utilisant un des modèles internes de WEAP 
nécessite d’un lien à partir des eaux souterraines au bassin versant. D'autres spécifications, comme 
les éléments à partir desquels l'eau est prélevée et sur lesquels est appliquée, sont définis dans le 
fichier de liaison. 

La demande en eau est contrôlée par le coefficient de récolte Kc et par les paramètres climatiques 
précipitation et ET. WEAP calculera la demande en eau si l'évapotranspiration des plantes est plus 
élevée que les précipitations. 
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1. Glissez et déposez un lien de type « transmission link » de 
GW_MainUpper à C_MainUpper  

 

2. Mettez la priorité de la demande à 1  

 

3. Mettez la classe irrigated de l’occupation du sol à irrigated:  

Demand Sites and Catchments→C_MainUpper→Irrigation→Irrigated = 1  

 

  

 

 

 

 

 

 

 

 

 

4. Exécutez le modèle et évaluez les résultats à la vue des résultats. 
 

 

Exemple du bilan hydrique 
des classes d’occupation du 
sol: 
Vous pouvez voir que 
l'irrigation a lieu entre mai 
et juin quand la ET est 
élevée et la précipitation 
est faible. Bien que la 
précipitation reste faible en 
juillet et août, il n'est pas 
nécessaire d'irriguer car les 
cultures sont déjà 
récoltées. 
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5.2 Changements en occupation du sol 

Le but de cet exercice est d'étudier l'impact des changements dans l'utilisation du sol sur la recharge 
des nappes phréatiques. Afin de surligner les changements, la durée totale de ce modèle est 
prolongée à 10 ans. 

General → Years and time steps → last year of scenarios = 2009 

 

Occupation du sol 2000     Occupation du sol 2010  

 

  
 

5.2.1 Urbanisation  

Scenario: Les zones urbaines se développent vers l’occupation totale des bassins versants C_East et 
C_MainLower jusqu'en 2010. L'infiltration disparaît et toute la précipitation écoule vers les rivières. 

1. Laissez WEAP répéter les données dépendantes du temps pour chaque année (précipitations, ET, 
Kc): 

 

 

 

 

 

Choisissez l’option  
"cycle" 
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to GW_MainLower

to Catchment Inflow Node 5
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2. Augmentez la fraction du ruissellement de 50% en 2000 à 100% en 2009 et réduisez la fraction de 
la recharge des nappes en conséquence: 

Supply and Resources → Runoff and Infiltration → from C_MainLower → Runoff Fraction 

Supply and Resources → Runoff and Infiltration → from C_E ast→ Runoff Fraction 

 

Pour interpoler les fractions annuelles utilisez les fonctions Interp(2009, 100) et  Remainder (100). 
 

 

5.2.2 Croissance de l'irrigation 

La classe d’occupation du sol unirrigated va être modifiée pour être irriguée à partir de l'année 2001. 
 

1. Ajoutez un lien de type « transmission links » à partir de la nappe phréatique vers les bassins 
versants C_MainUpper , C_MainCentral et C_West. 

 

2. Dans ces bassins, définissez les classes d'occupation du sol non irriguées et irriguées comme 
irriguées (1) 

 

3. Mettez la fraction d'irrigation à 75% (= sur-irrigation) 

 

4. Exécutez le modèle et parcouriez les résultats 
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5.3 Approvisionnement de l’eau domestique à partir des forages 

Dans ce chapitre, vous allez introduire deux sites de demande domestique (City1 & City2), qui sont 
approvisionnés par des forages locaux. Vous avez besoin d’entrer des données dans WEAP et le 
fichier de liaison pour que cela fonctionne. 

 

1. Glissez et déposez deux sites de demande (City 1 et City 2) sur le Schéma.  

2. Ajoutez un lien type « Transmission link » de GW_MainUpper  à City 1 et un autre de 
GW_MainLower à City 2.  

3. Mettez  Annual Water Use Rate  pour les deux sites à 20 Million m³. 

4. Mettez Consumption  à 100%:  

Demand Sites and Catchments → Water Use →Consumption 

5. Passez en LinkKitchen et chargez la couche Wellfields.shp qui indique l'emplacement des 

deux forages. 

 

 

6. Sélectionnez tous les éléments du forage en haut et attribuez-les à City 2. Répétez l'étape 

avec le deuxième forage. L'aperçu devrait ressembler à:  
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7.  Sauvegardez le fichier de liaison et rechargez-le dans WEAP, si necessaire. 

8. Exécutez WEAP et visualisez le resultat du niveau piezometrique (Map-View) 

Le résultat montre un cône de dépression important autour les éléments que vous avez définis 

comme forages pour approvisionner le site de demande "City2". 
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5.4 Recharge artificielle 

La modélisation de la recharge artificielle (p.ex. puits d’injection) est similaire à la modélisation de 
l'abstraction. La seule différence est que l'eau n'est pas consommée par le site de demande mais elle 
est retournée à un nœud d'eau souterraine. L'emplacement de l'injection est défini dans le fichier de 
liaison par l’attribut de la demande. 

1. Ajoutez un site de demande « Artificial Recharge » au schéma et Mettez Annual Water Use 
Rate à 20 million de m³ et Consumption à 0% 

2. Ajoutez un lien type «Transmission link » de Main River au nouveau site de demande 
« Artificial Recharge » et un autre lien type « Return Flow » de ce même site vers l’eau 
souterraine GW_MainLower  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Passez en LinkKitchen et liez quelques éléments au site  ArtificialRecharge. L'aperçu devrait 
ressembler à l'image ci-dessous: 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Sauvegardez le fichier de liaison et retournez en WEAP. 

 

5. Parcouriez les résultats sur la vue de niveau piézométrique 
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L'injection d'eau a un effet similaire au prélèvement sur la nappe phréatique mais dans la direction 
opposée. Les effets de l’abstraction et la recharge artificielle sont visualisés avec Map at comme 
carte 3D (voir ci-dessous, images à gauche et en bas). L’image ci-dessous à droite montre les flux 
annuels calculés par WEAP. 
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5.5 Changement climatique 

Les impacts possibles du changement climatique sur le ruissellement de surface, les niveaux 
piézométriques et les débits des sources (comme une approche simplifiée de ce sujet complexe) sont 
entraînées par des changements sur les paramètres de la précipitation et l'évapotranspiration. 

Afin de visualiser les impacts du changement climatique, créez un nouveau scénario « Climate 
Change » et modifiez les paramètres suivants pour chaque bassin versant: 

 ETRef → Growth(3%)  

 Precipitation → Growth (-3%) 

 

Exécutez WEAP et visualisez le résultat pour groundwater storage. 

La comparaison des deux scénarios climate change et reference montre l'effet du changement 

climatique sur le stockage des eaux souterraines au fil du temps 

 

 

 


